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About This Guide

This ZENworks Virtual Appliance Deployment and Administration Reference helps you to deploy and

configure ZENworks Appliance to the ZENworks supported virtual infrastructure.

The information in this guide is organized as follows:

*

Chapter 1, “Overview,” on page 7

Chapter 2, “System Requirements,” on page 9

Chapter 3, “Appliance Deployment,” on page 11

Chapter 4, “ZENworks Configuration,” on page 19
Chapter 5, “Appliance Management,” on page 43
Chapter 6, “ZENworks System Management,” on page 51
Appendix A, “Troubleshooting,” on page 59

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the

online documentation.

Additional Documentation

ZENworks is supported by other documentation (in both PDF and HTML formats) that you can use to

learn about and implement the product. For additional documentation, see the ZENworks
documentation Web site.
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Overview

ZENworks is available as a virtual appliance that can be deployed to a supported virtual
infrastructure. ZENworks Appliance is built on a customized SUSE Linux Enterprise Server (SLES), and
comes pre-installed with ZENworks and thus helps save on operating system license costs.

After deployment, ZENworks can be configured by using an easy to use web based Console. Also, the
same console can be used to maintain ZENworks Appliance and perform basic tasks such as
executing commands, starting and stopping services, viewing logs, uploading, and downloading files.

You can also tweak basic server settings and monitor the server performance. With the new
ZENworks Appliance, it is significantly easier to move to a new major version of ZENworks.

Appliance supports r oot and zenadni n users.

The r oot and zenadmin users have the following privileges:

+ On Appliance

*

*

*

*

*

Ganglia Configuration

Ganglia Monitoring

Network

Time

Storage

System Services

Firewall

Administrative Passwords

Online Update

Shutting Down and Restarting ZENworks Appliance

+ On ZENworks

*

*

*

*

ZENworks Configuration
Terminal and File Explorer
Logs

Log Configuration

ZENworks Control Center
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System Requirements

ZENworks Appliance is a 64-bit (x86_64) virtual machine. The following sections provide the
requirements for deploying ZENworks Appliance onto a virtual infrastructure:

Table 2-1 ZENworks Appliance Requirements

Item Requirements

Hypervisor ZENworks Virtual Appliance can be deployed in the following
virtual machine environments:

* VMware ESXi 6.x

+ Microsoft Hyper-V Server Windows 2012, 2012 R2, and
2016

* XEN on SLES 12, SLES 15 and the support packs

+ Citrix XenServer 7.x and Citrix Hypervisor 8.x

Virtual Machine Configuration ZENworks Appliance requires the following minimum
configuration that have been preconfigured by default:

¢ RAM: 16 GB minimum

+ Disk Space:

* CPU Cores: 8
ZENworks requires two hard disks. One hard disk of size is pre-
configured with the appliance that uses the SLES 12 SP4

operating system and the other hard disk of minimum size 40 GB
should be added for the ZENworks data.

Depending on your requirement, you can increase the pre-
configured disk space after deploying ZENworks Appliance

IP Address The server must have a static IP address or a permanently leased
DHCP address.
Database The ZENworks Appliance can be configured to use any of the

ZENworks supported database and the database must meet the
database requirements.

For more information, see Database Requirements in the System
Requirements.

System Requirements
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Item Requirements

Administration Browser The following are supported web browsers for the appliance
console:

¢ Internet Explorer 11 and above

+ Firefox version 58 and higher

¢ Edge 40 and above

¢ Chrome version 55 and higher

* Firefox ESR version 60

Supported Languages These are the supported languages for the appliance console:

¢ English - en

¢ French - fr

¢ German - de

* ltalian - it

* Japanese -ja

+ Portuguese (Brazilian)

+ Simplified Chinese - zh_CN
+ Traditional Chinese - zh_TW

¢ Spanish - es

10 System Requirements



3.1

Appliance Deployment

To deploy ZENworks Appliance, perform the tasks in the following sections:

+ Section 3.1, “Deploying the Appliance,” on page 11
+ Section 3.2, “Configuring the Appliance Settings,” on page 20

+ Section 3.3, “Known Issue,” on page 21

NOTE: For more information on the upgrade path, see ZENworks Version Currency document.

Deploying the Appliance
To deploy ZENworks Appliance, perform the following:

1 Ensure that the virtual machine to which you want to deploy ZENworks Appliance meet the
requirements listed in the ZENworks 23.3 System Requirements (https://www.novell.com/
documentation/zenworks-).

2 Download the ZENworks 2020 Update 2 Appliance file from the Software Licensing and
Downloads portal (SLD) or download the multi-part ZENworks Appliance ZIP files and create the
open virtualization archive (OVA) file.

Based on your hypervisor, download the relevant file:
+ VMware ESXi: Download the . ova file.
+ Microsoft Hyper-V: Download the . vhd or . vhdx file.
+ Xen Server on SLES 12: Download the xen. t ar. gz file.
+ Citrix Hypervisor (formerly XenServer): Download the xva. t ar. gz file.

+ Proxmox: Download the. ova file.

NOTE: On a Windows device, use the native support fort ar to extract the xva. t ar. gz file. To
extract the file, on the command prompt, specify the following:

tar -xjvf <xva.tar.gz file>

3 Deploy the ZENworks Appliance to the hypervisor by downloading and extracting the file (. ova,
.vhd,. vhdx, . xvaor.raw).

4 After deploying ZENworks Appliance, you must add a hard disk with a minimum size of 40 GB
for the ZENworks data before you power on the Virtual Machine.

Depending on your content requirement, you can increase the pre-configured disk space after
deploying ZENworks Appliance.

5 Continue with the next task, “Configuring the Appliance Settings” on page 20.
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The following hypervisors are supported for deploying the appliance:

Section 3.1.1, “Deploying the Appliance on Microsoft Hyper-V,” on page 12
Section 3.1.2, “Deploying the Appliance on Xen,” on page 13

Section 3.1.3, “Deploying the Appliance on VMware ESXi,” on page 15
Section 3.1.4, “Deploying the Appliance on Citrix Xen,” on page 16

Section 3.1.5, “Deploying the Appliance on Proxmox,” on page 17

3.1.1 Deploying the Appliance on Microsoft Hyper-V

1.

Log in to the host server either locally or from a remote workstation.

You can use Windows Remote Desktop to log in to the host server from a remote workstation.

Create a new directory in the location where you want each virtual machine to reside (for
example, C: \ User s\ Publ i c\ Docurment s\ Hyper-W Vi rtual Hard D sks). Inalater step,
you will download the software to this directory.

As a best practice, give this directory the same name as the name that you plan to use for your
ZENworks virtual appliance. For example, if you plan to name the ZENworks appliance
ZENworks1, the name of this new directory should also be ZENworks1.

Download the ZENworks software (ZENwor ks<ver si on>_Appl i ance- x86_64. vhd. zi p) to
the directory on the host server that you created in Step 2.

You can access the software from the Micro Focus Customer Center.

Extract the ZENwor ks<ver si on>_Appl i ance- x86_64. vhd. zi p file to the directory on the
host server that you created in Step 2.

5. Open the Hyper-V Manager.

In Hyper-V Manager, on the left hand side, right-click the machine name. This is the host where
you want to create the new virtual machine, then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7. Review the Before You Begin page, then click Next.

In the Name field, specify a name for the new virtual machine. For example, ZENworks1.

9. Click Next.

10.
11.

12.
13.
14.

15.
16.

Select the generation of the virtual machine.

In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual
machine. 16 GB is the recommended minimum for ZENworks.

Click Next.
On the Configure Networking page, select the networking card of your choice, then click Next.
Configure the bootable disk image:

a. On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then
browse to the .vhd file that was downloaded.

b. Click Open to select the file, then click Next.
Click Finish.

If you have not added a second hard disk, then ensure that a second hard disk is added before
you power on the virtual machine.

Appliance Deployment
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3.1.2

Perform the following steps to add the second hard disk:

In Hyper-V Manager, right-click the device that you just created, then click Settings.

T o

In the Hardware section, select SCSI Controller, select Hard Drive, then click Add.
Select Virtual hard disk, then click New.

Review the Before You Begin page, then click Next.

Select the required Disk Format and then click Next.

On the Choose Disk Type page, select Fixed size, then click Next.

@™ -~ O 2 o

On the Specify Name and Location page, specify the following information, then click Next:
Name: Specify a name for the hard disk. For example, ZENDisk2.
Location: Specify the location where you want the hard drive to be located.

h. On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size
for the hard disk. 80 GB is recommended.

i. Click Next.
j. Review the summary information, and then click Finish.
k. Click Apply > OK.

17. Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for
the appliance, as described in Step 15.

18. Right-click the virtual machine, then click Connect.

19. Continue with Configuring the Appliance Settings.

Deploying the Appliance on Xen

1. Login to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on
Linux:

ssh -X root@host_ip_address
You must use the -X in the command in order to display the GUI installation program. The steps
in this section use the GUI installation program to configure the server.

2. Navigate tothe/var/|i b/ xen/i mages directory on the host server.

3. Create a new directory inside the images directory where you can download ZENworks.

As a best practice, give this directory the same name as the name that you plan to use for your
ZENworks virtual appliance. For example, if you plan to name the ZENworks appliance
ZENworks1, the name of this new directory should also be ZENworks1.

You can download the software from the Micro Focus Customer Center.
4. Change to the directory that you just created.

5. Download the ZENworks software (ZENwor ks<ver si on>_Appl i ance-
x86_64. xen. t ar. gz) to the current directory on the host server.
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6. Untar the ZENwor ks<ver si on>_Appl i ance- x86_64. xen. t ar. gz file in the directory
where you downloaded it.

You can use the following command to untar the file:
tar -Sxvzf ZENworks<version>_Appliance-x86_64. xen.tar. gz

ZENworks-version directory is created, which contains a .raw file that you will use to run the
virtual image. This process can take a few minutes.

7. From the host server, run the following command to launch the GUI configuration menu:
vm-install
The Create a Virtual Machine wizard is displayed.
8. Click Forward.
9. Select | have a disk or disk image with an installed operating system, then click Forward.
10. Select SUSE Linux Enterprise Server <version>, then click Forward.

11. Rename the virtual machine by clicking Name of Virtual Machine, then specifying a new name
in the Name field. Then click Apply.

12. Configure the amount of memory and number of CPUs that Xen allocates for the ZENworks
appliance.

a. On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of available memory that is available on the host
server.

Initial Memory: 16 GB is the recommended minimum amount of memory.
Maximum Memory: Set this to the same value that you set for Initial Memory.
Available Processors: Displays the number of available processors on the host server.

b. Click Apply.

13. Configure the bootable disk image:

a. On the Summary page, click Disks.

b. Click Hard disk.

c. On the Virtual Disk page, specify the following information:
Source: Click Browse, then browse to the .raw file that you untared in Step 6.
Protocol/Storage Format: Select file.
Size (GB): The default size is shown in GB. This cannot be changed.
Create Sparse Image File: This option is not available.
Read-Only Access: Do not select this option.

d. Click OK.

14. Add a separate Xen hard disk. You must add a hard disk to the virtual machine before you
choose this option. If you have not already added a hard disk, click Power Off Virtual Machine,
modify the virtual machine settings to add a hard disk, then power on the virtual machine.

a. On the Disks page, click Hard disk.
b. On the Virtual Disk page, specify the following information:
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Source: This field should already contain the path to the .raw file that will be created when
the virtual machine is created. If desired, you can rename the disk in the source field from
diskO to a name of your choosing.

Size (GB): Specify the amount of hard disk space that you want to allocate. 80 GB is
recommended.

15. Click OK > Apply.

16. Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk for
the appliance, as described in Step 14.

17. Continue with Configuring the Appliance Settings.

3.1.3 Deploying the Appliance on VMware ESXi

The ZENworks Appliance is stored in an open virtualization archive format and you can deploy it to
the VMware infrastructure by using the VMware VSphere Client application.

1. Download the ZENworks software (ZENwor ks<ver si on>_Appl i ance- x86_64. ova) to your
management workstation.

You can download the software from the Micro Focus Customer Center.

2. Inthe vSphere client, click File > Deploy OVF Template.

NOTE: If the virtualization software you are using does not support .ovf, you must convert the
.ovf file to .vmx using the VMware OVF Tool available on the VMware Website.

Browse to and select the downloaded .ova file (ZENwor ks2020_Appl i ance- x86_64. ova).
Click Next.

Click Next again.

In the Name field, rename the ZENworks appliance to a name of your choice, then click Next.
Click Next to accept the default for the disk format.

Click Finish.

Create a separate VMware hard disk for the appliance. This is the location where you will store
your ZENworks files.

L K N O U kAW

a. Inthe vSphere client, right-click the virtual machine that you just created, and for which
you want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.
b. On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.
c. Select Hard Disk, then click Next.
d. Select Create a new virtual disk, then click Next.

e. Inthe Disk Size field, specify the amount of hard disk space that you want to allocate. 80
GB is recommended.

f. Select a datastore, then click OK.
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10.

11.
12.

1.

g. Click Next.
h. Click Finish.
Increase the amount of memory that VMware allocates for the ZENworks appliance.

a. Inthe Virtual Machine Properties window, select Memory, then increase the setting to a
suitable size for your environment. 16 GB is recommended.

b. Click OK to exit the Virtual Machine Properties window.
Power on the appliance (virtual machine).

Continue with Configuring the Appliance Settings.

Deploying the Appliance on Citrix Xen

Download the ZENworks software (ZENwor ks<ver si on>_Appl i ance-
x86_64. xva. tar. gz) to your management workstation.
You can download the software from the Micro Focus Customer Center.

In the Citrix XENCenter client, right-click the server on which you will install ZENworks
Appliance, then click Import.

NOTE: On a Windows device, use the native support for t ar to extract the xva. t ar. gz file. To
extract the file, on the command prompt, specify the following:

tar -xjvf <xva.tar.gz file>

Import Source: Browse to ZENwor ks<ver si on>_Appl i ance- x86_64. xva. tar. gz
extracted folder and select the ZENwor ks<ver si on>_Appl i ance- x86_64- <bui | d-
no>. xva file.

Location: Click Next to continue with the default settings.

. Storage: Select one or more storage repositories (SRs) where the disk images for the imported

VMs will be placed, then click Next.

Network: Select network to connect VM. Select the Virtual network interface and then click
Next

Review all the import settings and then click Finish to begin the import process and close the
wizard.

The import progress is displayed in the status bar at the bottom of the XenCenter window and
also on the Logs tab.

Create a separate hard disk for the appliance. This is the location where you will store your
ZENworks files.

a. In the Citrix XenCenter client, select the virtual machine that you just created, and click on
the Storage tab.

The Virtual Disks page is displayed.
b. Click Add.
The Add Virtual Disk dialog box is displayed.

c. Inthe Name field, specify the name of the virtual disk.

Appliance Deployment


https://www.microfocus.com/customercenter/

d. In the Size field, specify the amount of hard disk space that you want to allocate. 80 GB is
recommended.

e. Click Add.
9. Power on the appliance (virtual machine).

10. Continue with Configuring the Appliance Settings.

3.1.5 Deploying the Appliance on Proxmox

1. Download the ZENwor ks23. 4. 0_Appl i ance. ova file to your Proxmox device. You can
download the .ova file from the Software Licensing and Downloads portal (SLD).

2. Extract the .ova file by performing the following steps:

a. Login to the Proxmox server using SSH, and locate the folder where you have downloaded
the .ova file.

b. Extract the .ova file in the same folder by using the command:tar xvf <ova file
nane>.

Once you extract the ova file, you get 3 files: .ovf, .mf and .vmdk files. The .ovf file contains
the virtual machine configuration whereas the .vmdk file is the first disk for appliance.

NOTE: You can create the virtual machine in Proxmox either manually by using Proxmox
Console and set the required memory, CPU, and other parameters, or by using the .ovf file that
you extracted in the above step to create the virtual machine with default values.

3. Create the virtual machine with default values by using the following command:
gm i nportovf <vnmi d> <source> <storage> --format qcow2, where
+ vmid- Enter a unique id.
+ source- The full path of the .ovf file.

+ storage- The virtual machine storage name. You can find the virtual machine storage name
in the Proxmox console.

+ format- The disk format.

For example, gm i nport ovf 15001 ZENwor ks23.4.0_Appliance-x86_64-
ZENwor ks2020_23. 4. 0-dev-23.4_GMC-E. ovf | ocal --format gcow2

NOTE: Proxmox uses the Logical Volume Management (LVM) system that understands only
the qcow?2 format, which is the default virtual disk image format for virtual machines.

4. Import the first appliance disk to the newly created virtual machine by using the following
command:

gm di sk i nport <vm d> <source> <storage> --format gcow2, where
+ vmid- Enter the same vmid that you entered in step 3.
+ source- The full path of the .vmdk file.

+ storage- The virtual machine storage name. You can find the virtual machine storage name
in the Proxmox console.

+ format- The disk format.
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5. Setup the virtual machine for the appliance first boot by performing the following steps:

a. Login to the Proxmox and locate your virtual machine.

= Datacenter

Eb pve

15001 (ZENworks23 4)
222 localnetwork (pve)
£ it/ local (pve)
£ (] local-ivm (pve)

& Summary
>_ Console

ZENworks23.4
J Hardware
& Cloud-Init i Swifi
£ Options < HAState
= Task History B Node
@ Monitor {& CPU usage
Backup

13 Replication
D Snapshots

=1IPs
U Firewall

of' Permissions

Memory usage

stopped

none

pve

0.00% of 8 CPU(s)

0.00% (0 B of 16.00 GiB)

& Bootdisk size 0B

No Guest Agent configured

b. Click Hardware. This displays the list of hardware. The disk that you created using the
vmdk file is also displayed in the hardware list as Unused Disk 0 along with the storage
name appended in the description. This Unused Disk 0 is the first hard disk of the appliance,
which is created under the local-lvm storage.

B2 Datacenter

Edit Disk Action

16.00 GiB

& (1 sockats, B cores)

Default (SeaBIOS)

Default

Drefault (14404x)

Default (LS| 53CB95A)

local 15001/vm-15001.disk-0 qgeow2
| locak-lvm vm-15001-disk-0

b e & Summary Add Remove
15001 (ZENworks23 4) >~ Console EE Memory
EE localnatwork (pve) 2 Hardware & Processors
£ Options & Display
ﬂ Maching
[ HEkry £ 5CSI Controller
@ Monitor & Hard Disk (scsi0)
B Backup B Unused Disk 0
13 Rephcabon

D Snepshots

c. Select the Unused Disk 0 and click Edit.

d. Inthe Add Unused Disk dialog box, click Add to add the .vmdk file that you imported to this
virtual machine using disk import command in Step 4.

Add: Unused Disk

3 m Bandwidth

Bus/Device

A ]

SCSI Controller

sk image

S5SD emulation

Read-only

© Help

| scsI 1
Default (LS| 53C895A)

local-lvmivm-15001-disk

Cache
Discard

1D thread

Backup
Skip replication

Async 10

The primary .vmdk disk is added to the virtual machine.
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e. Add the second hard disk to the appliance. This hard disk will be used to store the content.
To add the second hard disk, from the Hardware menu click Add and then click Hard Disk

j

Seres Vaw o

B Datacentes
B e
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B locanemwark (pve)
i B oca [pve|

B [ iocsi-vm ipva)
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B Summary A3
_ Console g Bt ek 18 00 B
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= - Dietcs {2408)
= Task Hstory =% S0 Device
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0 Fepicataon H i) a1000=0C 24 11 TF 11 CA brdge=vmbe] leewall=1
i ) Audo Dovice #

D Snapshots
0 Friwal

o' Pemissons

A

Al RNG

tocal 15001 v 15007 Gk, O growd

In the Add Hard Disk dialog box, enter Storage and Disk size and click Add. Choose the right
amount of space for this hard disk based on your zone requirements.

Add network device by clicking Hardware > Add -> Network Device.

In the Add Network Device dialog box, enter the required details for the networking device
that would work in your environment.

Set the right boot order to ensure the appliance boots from the first hard disk that you
added in step d. To configure the boot order, click Options > Boot Order and then click Edit.

EE Datacenter
B pve
S 15001 (ZENworks23.4)
B locainetwork (pve)
= [t/ local (pve)
= ocal-lvm {pve)

aga@®@e@erOr

Summary
Console
Hardwarne
Cloud-1na
Options
Task Hestory
Monitor
Backup
Replication
Snapshals

Firassall

Edit Revert

Name ZENworks23 4
Start at bool Mo

Start'Shutdown order order=any

05 Type Critvar

Boot Order scsil, sosi2, netd
Use {ablel for poaniar Yos
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In the Edit: Boot Order dialog box, drag the first hard disk (the first disk is always 90 GB in
size) to the top and then select the Enabled check box for the first disk. Click Ok to save the

boot order configuration.
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k.

= 1 & scsil lecal-lvm vm-15001-disk-0 size=90G
= = nelld e1000=BC.:24:11.A0.D4:79 bndge=vmbr0 firewall=1
= 2 scsi2 local-lvm vm-15001-disk-1 size=120G

Drag and drop to reorder

© Help

Click Start to boot the virtual machine.

6. Click the >_ Console button displayed at the top-right side of the window, to navigate to the
appliance screen.

7. Continue with Configuring the Appliance Settings.

3.2 Configuring the Appliance Settings

To configure the appliance settings, perform the following:

1 On the License Agreement page, select the required License Language and Keyboard Language,
then click Accept.

2 On the Passwords and Time Zone page, specify the following information, and then click Next:

*

*

*

*

*

root Password and Confirmation: The root password for ZENworks Appliance.
zenadmin Password and Confirmation: The zenadmin password for ZENworks Appliance.

NTP Server: The IP address or DNS name of the external Network Time Protocol (NTP)
server.

It is recommended to set up the NTP server in accordance with the virtual infrastructure
guidelines.

Optional NTP Server: The IP address or DNS name of the external Network Time Protocol
(NTP) server.

Region: The local region.

Time Zone: The local time zone.

3 On the Network Settings Page, you can:

*

*

Select the Static IP Address: If you select this option, then perform Step 4.

Select the DHCP IP Address: If you select this option, enter the Host name, and then click
Next.

4 On the Network Settings page, specify the following information, and then click Next:

*

Hostname: The Fully Qualified Domain Name (FQDN) associated with the appliance IP
address. For example, server. donmai n. com

The hostname must be resolveable, or some features in ZENworks do not work properly.
Server names must support the DNS requirements, or the ZENworks login fails. Acceptable
characters are the letters a-z (uppercase and lowercase), numbers, and the hyphen (-).
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+ Obtain IP Address using DHCP: Select this option to get the IP Address using DHCP
address. If you select this option IP Address and Network Mask will be disabled.

+ |P Address: The server must have a static IP address or a permanently leased
DHCP address.
+ Network Mask: The network mask associated with the appliance IP address.

+ Gateway: The IP address of the gateway on the subnet where ZENworks Appliance is
located.

+ DNS Server: The IP address of a primary DNS server for your network.

+ Optional DNS Server: The IP address of a primary DNS server for your network.

+ Domain Search: By default, domain that you specified in the Hostname field is displayed.
+ Optional Domain Search: The alternate domain.

If you have not added a hard disk after deployment, then a warning message is displayed. In this
scenario, you need to power off the virtual machine, add a hard disk, power on, and then
continue with Step 2.

5 On the Data Store Location page, verify the new hard disk that you added.
6 Click Configure.

After the appliance configuration, URL is displayed. Use the URL (ht t ps: / / <FQDN>: 9443) for
administering the appliance and configuring ZENworks.

7 Continue with one of the following:
Configuring the First Primary Server

Configuring the First Primary Server with an Existing Schema

Known Issue

After ZENworks Appliance configuration, the security updates (product and operating system
patches) could not be applied as users were unable to register to Micro Focus Customer Center
(MFCC) server or a Local Subscription Management Tool (SMT) server.

To resolve this issue, apply the ZENworks 23.4 - FTF 94 or later and retry to register on the Online
Update page. For steps to apply the ZENworks 23.4 - FTF 94, see Official Primary Server FTF 94 on
ZENworks 23.4.
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ZENworks Configuration

The following sections provide the configuration flow for these process:

+ Section 4.1, “Configuring the First Primary Server,” on page 19

*

Section 4.2, “Configuring the First Primary Server with an Existing Schema,” on page 25

*

Section 4.3, “Configuring the Additional Primary Servers,” on page 33

*

Section 4.4, “Database Configurations,” on page 37

*

Section 4.5, “Logs,” on page 42

4.1 Configuring the First Primary Server

After deploying the ZENworks Appliance to a virtual machine, perform the following steps to
configure the ZENworks Appliance for the first Primary Server:

1 Launch the URL on a supported web browser.

The URL (htt ps: // <FQDN>: 9443 or ht t ps: // <i paddr ess>: 9443) is displayed on the
appliance console.

2 Loginto the ZENworks Appliance with the r oot or zenadmni n credentials that were specified in

Step 2, in the Section 3.2, “Configuring the Appliance Settings,” on page 17.

3 In the Appliance console, click ZENworks Configuration to initiate ZENworks appliance
configuration.

I @ Before using ZENworks, you must complete the ZENwarks Appliance configuration. To configure, click ZENworks Configuration.

Appliance Configuration

7 0O 8 & ©§ 4 ©

Metwork Time Storage System Senvices Firewall Administrative Online Update
Passwords

ZENworks

@ _===) —
ZEMworks Terminal & File Logs
Configuration Explorer
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You will be redirected to a new browser tab.

NOTE: Ensure that you have enabled or allowed the pop-up in your browser.

In the new tab, the ZENworks License Agreement page is displayed. Accept the terms of the
license and click Next.

In the Configure ZENworks Primary Server screen, select Create a New ZENworks Management
Zone, and then click Next.

Configure ZENworks Primary Server

This server can either be configured as a first Primary Server by creating a new Management Zone or configured as an additional Primary Server to an existing Management Zone.

]

Add the server to an existing ZENworks Management zone Create a New ZENworks Management zone

In the background, a system requirement check is performed automatically. The system runs
the prerequisite validation for Hardware, Software, Network, and File system components.

If there are any failure in prerequisite validation, the system displays the warning or error
details for the component. Rectify the issue, and then click Re-run System Check to perform the
prerequisite validation again.

After the validation is complete, click Next.

7 On the Zone Configuration screen, specify the following:

+ Zone name: A unique Management Zone name. The zone name can have a minimum of 6
characters and a maximum of 20 characters. It must not contain spaces and special
characterssuchas (@ S[]/:*?|><"&%{};+()!~"). The zone name is displayed in
ZENworks Control Center.

+ Password: The administrator password is used for logging into the ZENworks Control
Center. The password should have a minimum of 6 characters. By default, the login
username is administrator. After completing the installation, you can add other
administrator names in ZCC that can be used to login to the Management Zone.

The password should have a minimum of 6 characters. It should contain an uppercase and
a lowercase letter, a numeric character, and a special character (!, @, #, S, », *).

+ Confirm Password: Use this field to confirm the password. If there is a mismatch, an error
message is displayed after you click Next. You must re-enter the correct passwords.

By default, ZENworks creates an administrator account with the administrator as the login
name. This password can be used to log into the ZENworks Control Center as the default
administrator.

ZENworks Configuration



Zone Configuration

Specify a unique name for the zone, and password for the default administrator account. Select a database that supports the number of devices you want to manage in this zone.

Basic Details

Zone Name®:

Password": Confirm Password":

ZENworks Database Type
Embedded External Microsoft Ovac]
PostgreSQL PostgreSQL SQLServer yacke

(L 00, 00 A
{Upto 5,000 Devices) {Upto 20,000 Devices) {Upta 40,000 Devices) (51t 800,000 Beice)

In the ZENworks Database Type section, Select the ZENworks database type.

Depending on the number of devices you plan to manage in this ZENworks Management Zone,
you can select any of the following databases:

+ If you have 5,000 or fewer devices, you can use the Embedded PostgreSQL or Remote
PostgreSQL database.

+ If you have up to 40,000 devices, you can use Microsoft SQL Server or Oracle.

+ If you have up to 100,000 devices, you need to use the Oracle Enterprise Edition (with
partitioning).

Ensure that the server where you want to install the external database meets the Database
Requirements.

The following are the supported databases:

+ Embedded PostgreSQL: ZENworks automatically installs the embedded database on the
current server.

For configuration information, see “Embedded PostgreSQL Database Configuration” on
page 38.

+ External PostgreSQL: This database must already exist on a server in your network. It is
recommended that you use a different server rather than the current server.

For configuration information, see “External PostgreSQL Database Configuration” on
page 38.

+ Microsoft SQL Server: You can create a database or use an existing database on the
Microsoft SQL Server.

For configuration information, see “Microsoft SQL Server Database Configuration” on
page 39.

+ Oracle: You can create a database or use an existing database on the Oracle database
Server.

NOTE: If required, you can select Let ZENworks partition the database for improved
performance.

For configuration information, see “Oracle Server Database Configuration” on page 40.
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NOTE: If you are using an external database, then you need to create two databases, one to
save ZENworks data and another to save Audit data. The Audit database is used to record
changes made to ZENworks configurations, policies, and other settings. This data helps
administrators to adhere to security compliance, troubleshoot issues, and monitor user
activities.

8 Click Next.

9 On the ZENworks Port screen, open all the Ports and click Next.

ZENworks Ports

The ports displayed on this page are required by ZENworks. If required, you can modify the port numbers. On proceeding the given ports will be opened in the firewall.

Alternate Port for 7443: 7443
Alternate Port for 443: 443
Open Ports

The ports mentioned below are needed by ZENworks, but they are currently blocked by the Firewall on the device. To proceed, enable Yes, open all the above-listed ports

Port Details:

443, 7019, 7443 , 7444 , 7628 , 9971 , 54327 , 61491 , 61492 , 61495

O Yes, open all the above-listed ports

10 On the Configure Certificate Authority screen, choose the type of Certificate Authority (CA) for

the Management Zone, and then click Next.

NOTE: The certificate validity should be between 1 and 10 years. If you plan to use the server as

an MDM server, then to ensure communication with iOS and Mac devices, the certificate
validity should not exceed 2 years.

10a Internal CA: The certificate is automatically generated. The validity of the certificate is
between 2 to 10 years. If you are using the internal CA, then you can skip to Step 11.

10b External CA: If you are using an external CA, then you can select Secure certificate (.p12, or

.pfx), Root certificate and Server certificate with Private key, or Root certificate and Server
certificate as Certificate Type.

Configure Certificate Authority

ZEH vks requires a Certificate Authority (CA) to manage
externa CA,

; then the internal CA will co-exist with the external CA.
Certificate Autharity Type

Intemnal CA External CA

Generate the Certificate Signing Request (CSR) Generate (SR

I you have selected ZENworks to generate a (SR, then selact oot certificate and Server certificate. A Private Key is not required, as it dready exists on the server. For more information, see

I @ Howe: The cortificate validity should not excoed 2 years far an MOM server.

Selact Cortificate hype... -

ZENworks Configuration

ver certificates. ZENworks creates an internal CA to issue and manage identity certificates for mobile devices in the zone, If you select an



You can convert your certificate or key to ZENworks acceptable formats using the openssl
command line tool (available as part of most Linux distributions or as part of the cygwin
tool set).

For example, convert your PEM encoded private key to DER encoded thusly:

openssl pkcs8 -topk8 -nocrypt -in key.pem-informPEM -out key.der -
out f orm DER

PEM encoded certificate to DER encoded thusly:
openssl x509 -in cert.pem-inform PEM -out cert.der -outform DER
10b1 If you want ZENworks to generate a CSR, click Generate CSR.

If you generate the CSR from this page, the Private Key will be stored on the server.

Generate & Download CSR

Hey Strength®: 1024 « it

Organization Unit":

While configuring ZENworks, you need to have a signed server certificate, private key,
and a CA certificate. To get the signed server certificate, you need to generate a CSR
and validate by the CA.

Specify the following information.

+ Common Name (CN): The Fully Qualified Domain Name of the ZENworks Primary
Server. This name should match the server name in the URL, in order for browsers
to accept the certificate for SSL communication. For example,
mai | . novel | . com

+ Organization (O): Organization name.
+ Organizational Unit (OU): Organizational unit name, such as a department or
division.
+ City or Locality (L)
+ State or Province (ST)
+ Country or Region: Two-letter country code or region. For example, US.
+ Key strength: The required key strength can be 1024 or 2048.
After specifying all the details, click Download CSR to download the CSR.
10b2 Based on the required certificate type, specify the following details:
+ Secure certificate (.p12 or .pfx)

+ Secure certificate: This certificate stores the server certificate, any
intermediate certificate chains, and the private key in a encrypted file, which
is password-protected. It supports the . p12 or. pf x file format.
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+ Password: Password for the secured certificate file.
+ Root certificate and Server certificate

To use Root certificate and Server certificate, you must have generated a CSR by
using the Generate CSR link.

+ Root certificate: The top-level certificate in the certificate tree issued by the
CA that signed the Server certificate and any intermediate certificate chains.
It supports the. pem .crt, .cer, .der, .p7b, or.p7c file format.

+ Server certificate: It is a signed certificate that is used for the ZENworks
server. It supports the. pem .crt, .cer, .der, .p7b, or.p7c file
format.

NOTE:

+ When the server certificate is not directly signed by a root CA, a
certificate chain containing the server certificate and the intermediate
certificate that signed the server certificate needs to be provided in the
Server Certificate field. The Root Certificate can be a single, self-signed
certificate.

+ The server certificate should contain the complete chain of the
certificate. The top-level should consist of a root certificate, which is
signed by the Root CA, followed by the intermediate certificates, and
then the server certificate. The server certificate should be the leaf level
certificate.

+ The private key format can either be in Binary or Base64.

+ Root certificate and Server certificate with Private Key

+ Root certificate: The top-level certificate in the certificate tree issued by the
CA that signed the Server certificate and any intermediate certificate chains.
It supports the . pem .crt, .cer, .der, .p7b, or.p7c file format.

+ Server certificate: It is a signed certificate that is used for the ZENworks
server. It supports the . pem .crt, .cer, .der, .p7b, or.p7c file
format.

+ Private key: The private key file that is associated with the signed server
certificate. It supports the . der file format.

For subsequent deployments of Primary Servers to the Management Zone, the same
CA must be used to create the Secured Certificate with the Private Key that is
established by the first Primary Server’s deployment.

For more information, see the ZENworks SSL Management Reference.

11 The Summary screen displays the information that you provided to add a new Primary Server to
an existing ZENworks Management Zone.
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4.2

Summary

Following is the summary of the information that you have provided to add a new Primary Server to an existing ZENworks Management Zone.

Product Name: ZENworks 23.4.0.146
Installation Path: fopt/microfocus/zenworks
Management Zone Name: Infodev

Zone Type: New Management Zone

Certificate Authority: Internal

I o Note: Clicking Install initiates the ZENworks configuration.

12 Click Install to initiate the ZENworks configuration.

ZENworks configuration starts and it might take several minutes. The configuration process will
continue in the background even if you close the browser or the browser times out.

After successfully completing the installation, the status will be displayed as shown in the
following images:

€ zZENworks Installation Successful

ZENworks Services Status

& Al ZEMworks components are installed and running
correctly.

Installation is now complete. You may proceed to dose the window.

After ZENworks is configured, from the Home page you can use the ZENworks console to access
the ZENworks Configuration Management capabilities.

Configuring the First Primary Server with an Existing
Schema

NOTE: With a fresh installation of ZENworks 23.4, setting up a new Management Zone using a
Windows Server and Linux Server is not supported.
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If you want to setup a new zone using a Windows Server and Linux Server, we recommend you install
ZENworks 2020 Update 2 and then upgrade to ZENworks 23.4. For information see, (https://
www.novell.com/documentation/zenworks-2020-update-2/zen_installation/data/bookinfo.html)

+ Section 4.2.1, “Creating the Database Schema for Microsoft SQL,” on page 26

¢ Section 4.2.2, “Creating the Database Schema for Oracle,” on page 29

4.2.1 Creating the Database Schema for Microsoft SQL

Only a Database Administrator can create the database schema. This database schema will be later
used by the ZENworks Administrator to create a new management zone.

Prerequisite:
Make sure Java is installed on the system before running the Schema Creator Tool.
To create a database schema, perform the following steps:

1. Login to the Customer Portal or Software Licenses and Downloads.

2. From the Downloads screen, select the Product, Product Name (entitlement) and Version to
view the files. Click the Media Version column to sort the files.

3. Download and extract the Schema Creator Tool.

4. Navigate to the extracted folder and open the nssql - schema- det ai | s. properti es file.
The nssql - schena-det ai | s. properti es includes all of the details required for the
Schema Creator Tool to create the database schema, a ZENworks user to access the database,
and connection parameters.

5. Add the following parameters in the nsql - schema- det ai | s. properti es file:
For ZENworks database, add the following parameters:

+ ACCESS_PASSWORD-= Specify the Microsoft database password for the ZENworks
administrator to use.

+ ACCESS_USER= Specify the Microsoft database user name for ZENworks administrator.
+ ADMIN_PASSWORD-= Specify the database administrator password.

+ ADMIN_USER= Specify the database administrator user name. Make sure the
administrator has rights to create a user.

+ DATABASE_DIR= Specify the database directory where database should to be created.
Make sure to include \ \ in the path. For example, C. \\ Dat abase.

+ DATABASE_PORT= Specify the port number used by the external database server.
+ DATABASE_SERVER_ADDRESS= Specify the IP address of the external database server.
+ DATABASE_TYPE= Microsoft SQL
+ DB_NAME-= Specify the name for the new ZENworks database.
For audit database, add the following parameters:

+ AUDIT_ACCESS_PASSWORD-= Specify the Microsoft SQL database password for the audit
administrator to use.

+ AUDIT_ACCESS_USER= Specify the Microsoft SQL database user name for audit
administrator.
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+ AUDIT_ADMIN_PASSWORD-= Specify the Microsoft SQL database administrator password.
+ AUDIT_ADMIN_USER= Specify the Microsoft SQL database administrator user name.

+ AUDIT_DATABASE_DIR= Specify the database directory where database should to be
created. Make sure to include \ \ in the path. For example, C. \ \ Dat abase

+ AUDIT_DATABASE_PORT= Specify the port number used by the external database server.

+ AUDIT_DATABASE_SERVER_ADDRESS= Specify the IP address of the external database
server.

+ AUDIT_DB_NAME-= Specify the name for the new database.

6. After updating the Microsoft SQL properties file, run the following command from the extracted
location:

java -jar db-creation-tool.jar nssql-schema-details. properties
The JDBC URL is displayed after successfully executing the command.
7. Make of note of the JDBC URL for Audit and ZCM printed in the console at completion.

Next, on the Appliance, perform the following steps:

1 Launch the URL on a supported web browser.

The URL (https://<FQDN>:9443 or https://<ipaddress>:9443) is displayed on the appliance
console.

Log in to ZENworks Appliance with the root or zenadmin credentials.
Go to the System Services tile, select the SSH service, and click Start.

Download the silent installer properties file (silentinsall.config) from the following location:

v A W N

Modify the silent installer properties file (silentinstall.config) with relevant information
including the JDBC URL that was printed out in the tool (in step 6 above).

6 Edit the following parametersinthe si | entinstal | . confi g file:

Make sure to include the values as specified in the mssql - schema-det ai | s. properties
file.

+ DATABASE_JDBC_URL= Specify the JDBC URL that was copied after running the tool. The
database and Audit database JDBC URLs will be the same.

+ AUDIT_DATABASE_JDBC_URL= Specify the JDBC URL that was copied after running the tool.
The database and Audit database JDBC URLs will be the same.

+ DATABASE_ACCESS_USER= Specify the Microsoft SQL database password for the ZENworks
administrator to use.

+ OBFUSCATED_DATABASE_ACCESS_PASSWORD= Specify the Microsoft SQL database user
name for the ZENworks administrator to use.

+ AUDIT_DATABASE_ACCESS USER= Specify the Microsoft SQL database user name for audit
administrator.

+ OBFUSCATED_AUDIT_DATABASE_ACCESS_PASSWORD= Specify the Audit database
password for the ZENworks administrator to use.

+ USE_EXTERNAL_DB_POSTGRESQL= Specify O (zero) if you do not want to use an external
PostgreSQL database.

¢ SSL SERVER_CERT_VALIDITY= Specify the certificate validity as 2. This value is in years.
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+ IS _PRIMARY_SERVER= Set this value to t r ue to configure Microsoft SQL as a Primary
Server.

+ TargetTypes= Specify the target types as
FI RST_PRI MARY, ZEN SERVER, ROLE Appl i anceServer, sl es12

+ TOMCAT_SECURE_PORT= The port used by the Microsoft SQL database server. The default
port for Microsoft SQL in ZENworks is 443.

+ DATABASE_TYPE= Specify the database type as sql - server.

+ OPEN_FIREWALL_PORTS= Enter Y to open the firewall ports.

+ ZENSERVER_HOMIE-= Specify the following location to create a ZENworks Server directory:
/ opt/ m crof ocus/ zenwor ks

+ OBFUSCATED_ZONE_PASSWORD= Specify the Management zone password.

+ USE_EXTERNAL_DB_MSSQL= Enter 1 to use an external Microsoft SQL database.

+ ZENSERVER_BIN= Specify the following location to create a ZENworks Server bin:
/ opt/ m crof ocus/ zenwor ks/ bi n

+ SERVER_ADDRESSES= Specify a valid IP address or a Fully Qualified Domain Name (FQDN)
for the Microsoft SQL server.

+ CREATE_NEW_EXTERNAL_DATABASE= Enter 1 to create an external database.

+ ZEN_ADMIN_PORT= Specify the port used by the Microsoft SQL server. The default port is
7433.

+ USE_INTERNAL_CA= Specify 1 to use internal CA.
+ MANAGEMENT_ZONE_NAME= Specify the name of the management zone.

+ CREATE_NEW_EXTERNAL_AUDIT_DATABASE= The value 0 is the default and means that
the new external audit database will not be used.

+ DNS= Specify the DNS name or IP address of your zone's Primary Server.
+ |S_FIRST_SERVER= Specify 1 to create a first server.
+ |S_APPLIANCE= Specify 1 to create an appliance.

¢+ USE_EMBEDDED_DATABASE= The value 0 is the default and means that the embedded
database will not be used.

¢+ USE_EMBEDDED_DB_POSTGRESQL= The value 0 is the default and means that the
embedded PostgreSQL database will not be used.

+ CREATE_NEW_EXTERNAL_DATABASE= The value 0 is the default and means that the new
external database will not be created.

+ CREATE_NEW_EXTERNAL_AUDIT_DATABASE= The value 0 is the default and means that
the new external audit database will not be created.

+ USE_EXTERNAL_DB_ORACLE= The value 0 is the default and means that the external
database will not be used.

7 Copythesilentinstall.configfiletothe/t np folder on the appliance.
8 Invoke the silent installer by running the following command:

/usr/share/ ZCM nst al | er/ zenworks-instal |l er-1inux/zuper-installer.sh -f
/tnp/silentinstall.config
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4.2.2

NOTE: It is recommended to run this command from the local console session.

To view the real-time status of the installation, run the following command:

tail -f /var/opt/mcrofocus/|og/zenworks/
Progress_Tracker _ZENworks_lInstall .l og

To hide the Application configuration prompt in ZENworks, create the
ZENwor ksl sConfi gur ed file in/ opt / mi cr of ous/ zenwor ks by running the following
command:

touch /opt/ m crofocus/ zenwor ks/ ZENwor ksl sConf i gur ed

Creating the Database Schema for Oracle

Only a Database Administrator can create the database schema. This database schema will be later
used by the ZENworks Administrator to create a new management zone.

Prerequisite:

Make sure Java is installed on the system before running the Schema Creator Tool.

To create a database schema, perform the following steps:

1.
2.

Log in to the Customer Portal or Software Licenses and Downloads.

From the Downloads screen, select the Product, Product Name (entitlement) and Version to
view the files. Click the Media Version column to sort the files.

3. Download and extract the Schema Creator Tool.

Navigate to the extracted folder and open the or acl e- schema- det ai | s. properti es file.
The or acl e- schema- det ai | s. properti es includes all of the details required for the
Schema Creator Tool to create the database schema, a ZENworks user to access the database,
and connection parameters.

. Add the following parameters in the or acl e- schema- det ai | s. properti es file:

For ZENworks database, add the following parameters:

+ ACCESS_PASSWORD-= Specify the Oracle database password for the ZENworks
administrator to use.

+ ACCESS_USER= Specify the Oracle database user name for ZENworks administrator.
+ ADMIN_PASSWORD-= Specify the database administrator password.

+ ADMIN_USER= Specify the database administrator user name. Make sure the
administrator has rights to create a user.

+ DATABASE_ORACLE_SERVICE_NAME= Specify a valid service name for the Oracle server.
+ DATABASE_PORT= Specify the port number used by the external database server.

+ DATABASE_SERVER_ADDRESS= Specify the IP address of the external database server.

+ DATABASE_TYPE= Oracle

+ DB_NAME-= Specify the name for the new ZENworks database.

+ DATABASE_ORACLE_TABLETS_DBF= Specify the dbf fully qualified file path, it must be
unique. The specified physical path of the folder must be an existing path. Make sure to use
\'\ in the path. For example: C:\\ Or acl e\ \ Dat abase\ \ ZCMTABLE. dbf
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+ DATABASE_ORACLE_INDEXTS_DBF= Specify the dbf fully qualified file path, it must be
unique. The specified physical path of the folder must be an existing path. Make sure to use
\'\ in the path. For example: C:\\ Or acl e\ \ Dat abase\ \ ZCMTABLE. dbf

+ DATABASE_ORACLE_TABLE_TABLESPACE= The tablespace name for tables that exist on the
Oracle server.

+ DATABASE_ORACLE_INDEX_TABLESPACE= The tablespace name for indexes that exist on
the Oracle server.

For audit database, add the following parameters:

¢ AUDIT_ACCESS_PASSWORD-= Specify the Oracle database password for the audit
administrator to use.

¢ AUDIT_ACCESS_USER= Specify the Oracle database user name for audit administrator.
+ AUDIT_ADMIN_PASSWORD-= Specify the Oracle database administrator password.
+ AUDIT_ADMIN_USER= Specify the Oracle database administrator user name.

+ AUDIT_DATABASE_ORACLE_SERVICE_NAME= Specify a valid service name for the Oracle
server.

+ AUDIT_DATABASE_PORT= Specify the port number used by the external database server.

+ AUDIT_DATABASE_SERVER_ADDRESS= Specify the IP address of the external database
server.

+ AUDIT_DB_NAME-= Specify the name for the new database.

¢ AUDIT_DATABASE_ORACLE_TABLE_TABLESPACE= The tablespace name for tables that exist
on the Oracle server.

+ AUDIT_DATABASE_ORACLE_INDEX_ TABLESPACE= The tablespace name for indexes that
exist on the Oracle server.

+ AUDIT_DATABASE_ORACLE_TABLETS_DBF= Specify the dbf fully qualified file path, it must
be unique. The specified physical path of the folder must be an existing path. Make sure to
use \\ inthe path. For example: C:\\ Or acl e\ \ Dat abase\ \ ZCMIABLE. dbf

+ AUDIT_DATABASE_ORACLE_INDEXTS_DBF= Specify the dbf fully qualified file path, it must
be unique. The specified physical path of the folder must be an existing path. Make sure to
use \\ inthe path. For example: C: \\ Or acl e\ \ Dat abase\ \ ZCMI'ABLE. dbf

6. After updating the Oracle properties file, run the following command from the extracted
location:

java -jar db-creation-tool.jar oracle-schema-details.properties
The JDBC URL is displayed after successfully executing the command.
7. Make of note of the JDBC URL for Audit and ZCM printed in the console at completion.

Next, on the Appliance, perform the following steps:

1 Launch the URL on a supported web browser.

The URL (https://<FQDN>:9443 or https://<ipaddress>:9443) is displayed on the appliance
console.

2 Login to ZENworks Appliance with the root or zenadmin credentials.
3 Go to the System Services tile, select the SSH service, and click Start.

4 Download the silent installer file (silentinstall.config) from the following location:
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5 Modify the silent installer file (silentinstall.config) with relevant information including the JDBC
URL that was printed out in the tool (in step 6 above).

6 Edit the following parametersinthe si |l entinstal | . confi g file:

Make sure to include the values as specified in the or acl e- server-detail s. properties

file.

*

*

AUDIT_DATABASE_ACCESS_USER= Specify the ZENworks Audit database user name.

AUDIT_DATABASE_ADMIN_USER= Specify the ZENworks Audit database server
administrator user name.

AUDIT_DATABASE_ORACLE_INDEX_TABLESPACE= Specify the tablespace name for tables
that exist on the Oracle server.

AUDIT_DATABASE_ORACLE_SERVICE_NAME= pecify a valid service name for the Oracle
server.

AUDIT_DATABASE_ORACLE_TABLE_TABLESPACE= The tablespace name for indexes that
exist on the Oracle server.

CREATE_NEW _EXTERNAL_AUDIT_DATABASE= Specify 1 to create an external audit
database.

CREATE_NEW _EXTERNAL_DATABASE= Specify 1 to create an external database.

DATABASE_ACCESS_USER= Specify the Oracle database password for the ZENworks
administrator to use.

DATABASE_ORACLE_INDEX_TABLESPACE= Specify the tablespace name for indexes that
exist on the Oracle server.

DATABASE_ORACLE_SERVICE_NAME-= Specify a valid service name for the Oracle server.

DATABASE_ORACLE_TABLE_TABLESPACE= Specify the tablespace name for tables that exist
on the Oracle server.

DATABASE_TYPE= oracle

DNS= Specify the DNS name or IP address of your zone's Primary Server.
IS_APPLIANCE= Specify 1 to create an appliance.

IS_FIRST_SERVER= Specify 1 to create a first server.

IS_PRIMARY_SERVER= Specify 1 to create a first Primary Server.
MANAGEMENT_ZONE_NAME-= Specify the name of the management zone.

OBFUSCATED_AUDIT_DATABASE_ACCESS_PASSWORD= Specify the audit database
password for the ZENworks administrator to use.

OBFUSCATED_DATABASE_ACCESS_PASSWORD= Specify the Oracle database password for
the ZENworks administrator to use.

OBFUSCATED_ZONE_PASSWORD= Specify the Management zone password.
OPEN_FIREWALL_PORTS= Enter Y to open the firewall ports.

SERVER_ADDRESSES= Specify a valid IP address or a Fully Qualified Domain Name (FQDN)
for the Oracle server.

SKIP_PARTITIONING= Specify 0 (zero) to let ZENworks use partitioning with the Oracle
database. The default value is 1, which means that partitioning will not be used with the
Oracle database.

SSL_SERVER_CERT_VALIDITY= Specify the certificate validity as 2. This value is in years.
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TargetTypes= Specify the target types as
FI RST_PRI MARY, ZEN_SERVER, ROLE_Appl i anceSer ver, sl es12

TOMCAT_SECURE_PORT= The port used by the Oracle database server. The default port for
Oracle in ZENworks is 443.

USE_EMBEDDED_DB_POSTGRESQL= The value 0 is the default and means that the
embedded PostgreSQL database will not be used.

USE_EMBEDDED_DATABASE= The value 0 is the default and means that the embedded
database will not be used.

USE_EXISTING_EXTERNAL_AUDIT_DATABASE= The value 0 is the default and means that
the existing external audit database will not be used.

USE_EXISTING_EXTERNAL_ DATABASE= The value 0 is the default and means that the
existing external database will not be used.

USE_EXTERNAL_DB_MSSQL= The value 0 is the default and means that the external
Microsoft SQL database will not be used.

USE_EXTERNAL_DB_ORACLE= Specify 1 to use the Oracle external database.

USE_EXTERNAL_DB_POSTGRESQL= The value 0 is the default and means that the external
PostgreSQL database will not be used.

USE_INTERNAL_CA= Specify 1 to use internal CA.

ZEN_ADMIN_PORT= Specify the port used by the Oracle server. The default port is 7433.
ZENSERVER_BIN= Specify the following location to create a ZENworks Server bin:

/ opt/ m crof ocus/ zenwor ks/ bi n

ZENSERVER_HOME-= Specify the following location to create a ZENworks Server directory:
/ opt/ m crof ocus/ zenwor ks

DATABASE_JDBC_URL= Specify the JDBC URL that was copied after running the tool. The
database and Audit database JDBC URLs will be the same.

AUDIT_DATABASE_JDBC_URL= Specify the JDBC URL that was copied after running the tool.
The database and Audit database JDBC URLs will be the same.

MOUNT _PATH= Specify the following ZENworks installer path:
{usr/share/ ZCM nstal | er

7 Copythesilentinstall.configfiletothe/t np folder on the appliance.
8 Invoke the silent installer by running the following command:

[usr/share/ ZCM nstal | er/ zenworks-install er-1inux/zuper-installer.sh -f
/tnp/silentinstall.config

NOTE:
+ |tis recommended to run this command from the local console session.

+ To view the real-time status of the installation, run the following command in a new

console:

tail -f /var/opt/m crofocus/| og/zenworks/
Progress_Tracker _ZENworks_Install .l og
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To hide the Application configuration prompt in ZENworks Appliance, create the
ZENwor ksl sConfi gur ed file in/ opt / mi cr of ous/ zenwor ks by running the following
command:

touch /opt/ m crofocus/ zenwor ks/ ZENwor ksl sConf i gur ed

4.3 Configuring the Additional Primary Servers

43.1 Prerequisites

Before starting the procedure, ensure that you go through the following points:
+ Ensure that the new server that you are adding to the zone meets all the requirements. For
more information, see ZENworks System Requirements in the ZENworks Documentation site.

+ Ensure that the first Primary Server is at ZENworks 23.4. If the first Primary Server is at a lesser
version, then installation might fail.

+ The first Primary Server should be up and running.
+ If you are using an external database, then ensure that the database is up and running.

+ If your ZENworks Management Zone is using the internal ZENworks Certificate Authority (CA),
the new Primary Server is automatically issued a server certificate during installation.

+ If your zone is using an external CA, you must provide the new Primary Server with a valid
certificate issued from the external CA.

+ Ensure that you have taken a reliable backup of the Primary Server.

43.2 Adding a New Primary Server

To add a new Primary Servers to your existing ZENworks Management Zone, perform the following
steps:

1 Deploy ZENworks Appliance. For information, see Chapter 3, “Appliance Deployment,” on
page 11.
2 Launch the URL on a supported web browser.

The URL (htt ps: // <FQDN>: 9443 or ht t ps: // <i paddr ess>: 9443) is displayed on the
appliance console.

3 Log into ZENworks Appliance with the r oot or zenadm n credentials that were used in Step 2,
in the Section 3.2, “Configuring the Appliance Settings,” on page 17.

4 In the Appliance console, click ZENworks Configuration to initiate ZENworks appliance
configuration.
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I @ Becfore using ZENworks, you must complete the ZENworks Appliance configuration. To configure, click ZENworks Configuration.

Appliance Configuration

7 0 8 & & 4 ©

Metwork Time Storage System Senvices Firewall Administrative
Passwords

Online Update

ZENworks

o] &) E

ZEMworks Terminal & File Logs
Configuration Explorer

You will be redirected to a new browser tab.

NOTE: Ensure that you have enabled or allowed the pop-up in your browser.

5 Inthe new tab, the ZENworks License Agreement page is displayed. Accept the terms of the
license and click Next.

6 Select Add the server to an existing ZENworks Management zone, and then click Next.

Configure ZENworks Primary Server

This server can either be configured as a first Primary Server by creating a new Management Zone or configured as an additional Primary Server to an existing Management Zone.

e

Add the server to an existing ZENworks Management zone Create a New ZENworks Management zone

Requirements for the server that is being added to an existing ZENworks Management Zone:
¢ The DNS name or IP address of your zone's Primary Server

¢ The zone administrator credentials to add a new Primary Server

+ The additional Primary Server can be added only if all the Primary Servers in the zone are
upgraded to ZENworks

7 In the Connect to an Existing Primary Server, specify the following information, and then click
Next:
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Connect to an Existing Primary Server

To add a new Primary Server in a zone, specify the address of an existing Primary Server with the Certificate Authority role. Specify the administrator credentials with the required permission to add
Primary Servers.

Primary Server®:
Port™: 7443
Administrator’:

Password™

+ Primary Server: The first Primary Server’s FQDN or IP address.

¢ Port: The Port used by the first Primary Server in the Management Zone. The default port
is 7443.

NOTE: When adding a new appliance, ensure that you specify the default 7443 port, or any
custom port used when upgrading ZENworks.

+ Administrator: The ZENworks management zone's administrator user name.
+ Password: The password for the ZENworks management zone's administrator.
8 On the Open Ports screen, select Yes, open all the above-listed ports, and then click Next.

9 To communicate securely with the first Primary Server, in the Validate Primary Server Certificate
dialog box, select Click here to accept this certificate and proceed, and then click Confirm.

Validate Primary Server Certificate

Unknown Certificate

© Unsble to procesd as the server cortificate cannnt be validated. Do yau want to accept this certificate?

Issued To: CH=linue-pzjS.epm. blenevell com, OU=ZEMworks
Issued By: CH=linux-pzjS.epm. biznovell.com, OU=7FHworks, O=Internal Certificate Authority

H valid From: Tue Feb 07 16:03:54 15T 2073
Valid Until: 5un Feb 07 16:03:54 15T 2027

MDS Fingerprint: al:eg:
SHa1 Fingerprint: &1:1czf1

0:ad:67
32:5b:27:62:bi:45

a:09:43
:bb:9ar 392 37:59:06:50:92

@) click here to aceept this certificate and proceed

This dialog box is displayed only when an unknown certificate is detected.

10 Specify certificate details for the additional Primary Server.

NOTE: The certificate validity should be between 1 and 10 years. If you plan to use the server as
an MDM server, then to ensure communication with iOS and Mac devices, the certificate
validity should not exceed 2 years.

+ If an Internal certificate is used in the first Primary Server, ZENworks detects the internal
certificate and automatically issue the certificate.
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+ If an External certificate is used in the first Primary Server, choose the required certificate
(Server Certificate with Private Key or Server Certificate). If you have used the Generate CSR
link, then upload Server Certificate. Based on the certificate specify the following details:

+ Server Certificate: Browse to the signed certificate to be used for this server.

The certificate must be a SubCA (approved by SubCA) and CA (Approved by root CA)
certificates in order:

====Begi nni ng of the Certificate File====
=[Server Certificate]=

=[SubCA Certificate]=

=[CA Certificate]=

====End of the Certificate File====

+ Private Key File: This field is enabled if you select the Server Certificate with Private
Key option. Browse to the .der private key file that is associated with the signed
certificate.

To convert the PEM file to DER file, use the following command:

openssl| pkcs8 —-topk8 —nocrypt —in privateKey. key —i nform PEM —
out key.der —outform DER

To verify the privateKey.key file, use the following command:
openssl rsa -in privateKey. key -check

11 The Summary screen displays the information that you provided to add a new Primary Server to
an existing ZENworks Management Zone.

Summary

Following is the